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ABSTRACT 

Calculating Porosity and Cementation from Different Image Techniques Using Core Samples 

from Permian Carbonate of Midland Basin, Texas 

 

 

Gerardo Valenzuela and Jaime Martinez 

Department of Geology & Geophysics 

Texas A&M University 

 

Research Advisor: Dr. Juan Carlos Laya 

Department of Geology & Geophysics  

Texas A&M University 

 

 

 This study researched whether there were accurate alternative methods to evaluating 

porosity values and other rock property characteristics in Permian carbonate samples from well 

Lott 19-3, 4915’, Lott 19-7, 4940’- 5000’, and Lott 19-8, 4917’- 5000’ in the Happy Spraberry 

Formation. Through these techniques used pore types, porosity and cement values were 

identified, to determine whether these alternative methods of petrographic image analysis and 

Computed Tomography (CT) technology could be viable techniques to replace older image 

analysis methodologies that take more time, money and are far more destructive. To accomplish 

this, a workflow was developed to analyze petrographic images and CT scan data. These values 

were then evaluated for accuracy by comparing the results to a previous study which used helium 

injection testing, a method considered to have a high level of accuracy.  

The Happy Spraberry Field is located in the South Central part of Garza County, Texas. 

It forms part of the Eastern Shelf, which produces from a 100 foot thick carbonate interval and is 

the second largest oil field that produces from the Lower Clear Fork Formation in the Midland 

Basin. The formation consists of six facies that have been identified in previous studies. These 
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facies are oolitic skeletal grainstones and packstones, floatstones and rudstones, In situ 

Tubiphytes bindstones, and siltstones from slope deposits.  

There was a slightly lower trend in the porosity values from this study and the benchmark 

data from the helium test analysis. This discrepancy was attributed to the low resolution, and 

incomplete magnification of the microporosity from the computer and images. The results were 

within a reasonable range of the true porosity values, but can be improved by reworking the 

workflow used. The cement values obtained through this workflow helped demonstrate the idea 

that high cementation levels directly correlate to low porosity values. These results are 

considered to be accurate due to the specific way in which the workflow was modified to only 

color-change the pixels inside the cemented areas. Finally, it was concluded that rock 

characteristics, such as pore types, could be observed through image analysis techniques as long 

as the thin section images have a good resolution that allows for minimal distortion of the image.  
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CHAPTER I  

INTRODUCTION 
 

 

This research is relevant due to the prospect of a cheap and non-destructive alternative to 

standard methods in calculating porosity and cementation. Porosity is a rock property that 

indicates the ratio of pore volume to total rock volume, it is relevant because it can help 

determine the volume of natural resources trapped in a reservoir, which is a region where fluid 

can be stored in the strata. Cementation is another rock property that reduces porosity and 

permeability, and it is caused by the precipitation of minerals. This study compared two different 

techniques to identify porosity properties in carbonate rocks. The porosity for two plug samples, 

oriented along the vertical and horizontal axes, were cut from well Lott 19-3, 4815’, from a 

siltstone-grainstone transition facies from the Happy Spraberry Field. The reason this section of 

core was selected was to observe how the transition between the siltstone to the grainstone would 

be imaged once CT scanning was done on the plugs. In addition, petrographic image analysis 

was performed on a total of 34 thin sections from well Lott 19-7, 4940’-5000’ and Lott 19-8, 

4917’-5000’, in order to calculate porosity, cement, and to identify the different pore types 

present in the formation. 

In this study, the focus was to create a workflow to accurately and precisely measure 

porosity and cementation percentages, as well as pore type identification. The results for the 

porosity measurements obtained in this study were compared to total porosity measurements 

obtained by Mazingue (2004), whose values were gathered from helium injection analysis 

performed on plug samples that correspond to the depths of the thin sections analyzed in this 

thesis. A new workflow was created for analyzing the porosity from the CT scan data. While the 
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workflow used for image analysis of the thin sections, was borrowed from Grove and Jerram 

(2011) with slight modifications in the process. The program ImageJ was utilized in this study in 

order to conduct the two different image analysis techniques for calculating porosity and 

cementation. It is the main goal of this research to develop a workflow that can accurately and 

precisely measure porosity values from CT scan data and thin section images. In addition, 

cementation percentages and rock properties, such as pore types, were determined from 

petrographic image analysis. 

 

Geological Background 

The Happy Spraberry Field is located in Garza County, Texas, and is situated on the 

Eastern Shelf of the Midland Basin and produces from the Lower Clear Fork Formation (Figure 

1). It was discovered in 1988 by Bennett Petroleum that later, with their partner Torch Energy, 

drilled 15 wells. The reservoir units consists of complex mixed fine sandstone, along with lime 

and clay mudstone, siltstone, packstone, and grainstone. The carbonate interval of the Happy 

Spraberry Field is deduced to be from the Lower Leonardian, Early Permian, age based upon 

seismic correlations (Layman, 2002; Clayton, 2011; Ahr, W. M., 2011; Mazingue-Desailly, 

2004). The best reservoir facies is the oolitic grainstone and packstone due to the abundance of 

moldic porosity along with vuggy and intergranular porosity (Layman, 2002). This unit, the 

Happy Spraberry field, has been resedimented and has been deposited in the middle lower slope 

(Genty, 2006). 
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Figure 1. Map of Midland basin, with location of the Happy Spraberry field. The red star 

highlights the location of the wells utilized in this study. (Modified from Ahr and Hammel, 

1999). 

 

 

The Happy Spraberry Field is a stratigraphic trap reservoir that has an average depth of 

1509 meters (4950 feet) (Clayton, 2011). The Happy Spraberry field originally was considered to 

be a part of the Spraberry trend, but recently seismic correlations established that it is part of the 

Lower Clear Fork Formation (Layman, 2002) (Figure 2).  
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Figure 2. General cross section of the Midland Basin-Eastern Shelf transition. The red star marks 

the approximate position of the Happy Spraberry Field (From Layman, 2002). 

 

Previous Works 

The innovative development of the transverse axial scanning Computed Tomography by 

Hounsfield in 1972 for use in the medical field (Hounsfield, 1973), allowed for the disciplines of 

Petroleum engineering and Geosciences a new useful technique. This technique allowed them to 

examine the internal structure of materials with precise detail, by analyzing contrast in density 

and atomic composition. CT scan imaging can also help us with characterization of core 

materials. Identification of pyrite inclusion in sandstones were possible with this technique 

which opened ideas to how to characterize core samples in a non-destructive way (Wellington 

and Vinegar, 1987). CT scanning also provides the ability to measure samples at different scales 

ranging from 400 microns (Macro-CT scanning) to 20-5 microns (Micro-CT scanning), that help 

differentiate between solid, liquid and gaseous phases (Wildenschild et al., 2015). For these 

reasons, CT scanning was determined to be an excellent technique to calculate porosity values 

due to the high resolution that can be obtained, and its ability to identify density contrasts. 
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However, there are some limitations to CT scanning, as specialized equipment to perform these 

tests are expensive to acquire, they limit the size of the sample, and it is not always possible to 

identify different minerals (Jerram and Higgins, 2007).  

The complexity that originates from image analysis, is that no standard workflow exists 

for calculating porosity (Haines et al., 2015), an issue that wanted to be addressed in this study, 

in order to develop a reliable method that can be utilized for image analyses by the geoscience 

community. Total porosity had been calculated from various carbonate lithofacies, utilizing 

BSE-SEM photomicrographs to construct a greyscale image that can be thresholded in order to 

produce a binary image composed of a pore phase and a rock phase (Haines et al., 2015; Ehrlich 

et al., 1991). Where the ratio between the pore phase to rock phase would be calculated in order 

to determine the total porosity (Haines et al., 2015; Anselmetti et al., 1998).  An idea that was 

utilized in this study, for the CT scan data processing workflow, where the data obtained from 

the CT scans, once processed, would produce 16-bit greyscale images, which would then have to 

be thresholded to differentiate the pore phase from the rock phase.  

 In addition, image analysis and CT scan data processing offer many advantages over 

other methodologies such as thin section point counting. Estimates of pore, grain, and 

cementation often produced errors of more than a hundred percent, caused by the presence of 

microporosity within solid rock and the incorrect assumption that pore area in two-dimensions is 

proportional to the three-dimensional pore volume (Halley, 1978). A problem that wanted to be 

addressed in this study, in an effort to use image analysis and CT scan data processing to 

evaluate the presence of microporosity. Another advantage for image analysis is the ability to 

identify and quantify different rock characteristics, such as, pore types (Barrezueta et al., 2015).  
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A promising technique for image analysis allowed for easier porosity calculations in thin 

sections. The method utilized a blue color palette that needed to be applied through Photoshop 

into the previously scanned thin section image to later import the modified image into ImageJ 

(Figure 3).  However, this method’s accuracy was constrained by the quality of the images 

(Grove and Jerram, 2011). In an effort to reduce the error caused by the image quality, the thin 

sections used in this research project were scanned over a longer period of time, in an attempt to 

decrease the error caused by the resolution of the images. Utilizing the JPOR tool in ImageJ, one 

is able to measure the blue epoxy (void space) within a thin section (Grove and Jerram, 2011) 

which proved to be a reliable workflow for thin section analysis. In this research project, the 

workflow developed by Grove and Jerram (2011) was utilized with slight modifications in order 

to calculate the porosity in our blue epoxy stained thin sections.  

Figure 3. (A) An arbitrary thin section image impregnated with blue epoxy shows color 

variations of blue hue. (B) Palette developed to identify blue epoxy. (From Grove and Jerram, 

2011).  

 

In two separate studies done on the Happy Spraberry formation, pore geometry and 

percent porosity were calculated by capturing digital images from thin sections viewed under 

petrographic microscope, as well as identifying petrophysical characteristics (Layman, 2002). 
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The digital images were analyzed using a software called Pro Plus (Version 4.0). An image 

analysis method and program similar to the one utilized in this study. Through this method four 

pore facies were identified, which were classified on their pore type, size, and abundances. In the 

second study, from the same Happy Spraberry formation, total porosity values were obtained 

from helium injection testing, a method for calculating porosity that is considered to yield 

accurate results (Mazingue, 2004). The reason for using the results obtained in previous studies 

done on the Happy Spraberry formation was due to the coinciding wells, Lott 19-7 and 19-8, 

which were studied. Data for this study was specially selected to match wells analyzed by 

Layman (2002) and Mazingue (2004) in order to have a benchmark of results to compare and 

critique.  
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CHAPTER II  

METHODS  

 

 This study begun with a geologic literature overview of the Happy Spraberry field, which 

led to previous work done by Layman (2002) and Mazingue (2004). The workflow for this 

research contains the following steps, scanning prepared billets using a CT device, preparing thin 

section images with the applied color palette, formatting the images, and applying the JPOR 

plugin of ImageJ to calculate the porosity values of the thin section images and scanned data. 

Through this study it was found that Layman (2002) and Mazingue (2004) had performed 

porosity analysis on wells Lott 19-7 and 19-8 but, Mazingue (2004) used data from the helium 

injection analysis whose total porosity values are very accurate and will therefore be used as our 

benchmark for this study. While Layman (2002) used a slightly different petrographic analysis 

method to the one used in the present study, and whose results will also be used to compare to 

our image analysis porosity measurements. This project is focused on two wells Lott 19-7 and 

19-8, from the Happy Spraberry field due to the vast data regarding thin section analysis and 

porosity measurements that are available from previous studies. In addition, CT scanning has 

been done on two plugs cut from Lott 19-3, 4915’, in a vertical and horizontal orientation, in 

order to calculate porosity and examine how accurate the data is to other results from similar 

siltstone-grainstone transitions from the Happy Spraberry Field.  

 

Petrographic Image Analysis  

 A total of 34 thin section images were analyzed and used to describe the pore types that 

comprise wells Lott 19-7 (18 thin sections) and Lott 19-8 (16 thin sections). The pore types were 
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identified using a previously established classification system (Choquette and Pray, 1970), which 

describes the different porosities in relation to their depositional and diagenetic processes. In this 

study, the Happy Spraberry field was identified as having complete and incomplete moldic, 

interparticle, and intraparticle porosities within the differing facies comprising the two wells. 

 

Computed Tomography Imaging Data Acquisition 

Computed Tomography is an imaging procedure that uses X-ray tomography scanning to 

create detailed two dimensional images of the interior of objects, in this case core samples based 

on density differences. X-ray Tomographic imaging consists of directing X-rays at an object 

from multiple orientations and measuring the decrease in intensity along a series of linear paths. 

An algorithm is then used by the device to reconstruct the distribution of X-ray attenuation in the 

volume being imaged (Ketcham, 2001). This process creates a large number of two dimensional 

images, 2,237 for the samples analyzed in this study, that when put together will render the three 

dimensional body of the sample which allowed for the investigation of the internal structure of 

the rock without destroying the sample. For this study, initially a Macro CT scanning device was 

used which allowed the imaging of the sample, but due to the poor resolution, the smaller pores 

were not visible. The GE Phoenix Nanotom Micro Computed Tomography machine was then 

used for this study in order to achieve an image resolution of 11.5 microns for the analyzed plug 

samples from well, Lott 19-3. The Micro CT device proved better at imaging the pores in the 

samples than the Macro CT device.  To get the horizontal and vertical porosity planes, a vertical 

and horizontal plug was taken from Lott 19-3 at a depth of 4915 feet (Figure 4).  
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Figure 4. (A) Explanation of vertical and horizontal porosity planes in plug sample. (B) Image of 

horizontal and vertical plugs cut from depth. 

 

Then, discs from the plugs were cut to analyze the horizontal plane and the vertical plane 

(Figure 4-A). The technique required the samples to be in the shape of 25mm x 3mm billets 

(Figure 5). Those samples were scanned over a period of six hours which increased the 

resolution of the images. After the acquisition, the images were processed with ImageJ to 

calculate final porosity values. 
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Figure 5. (A) Original disc from John Lott#19-3 4915’. (B) ImageJ thermal filter overlaid onto 

original disc to show different pore densities. 

 

Computed Tomography Scan Data Analysis 
 

ImageJ is an open source, image processing software which is free for download and is 

user friendly. It allowed to open and read the data obtained from the CT scanning equipment 

under .dcm format and the thin section images that are in .bmp format. Utilizing ImageJ is a 

versatile and reliable tool to use various types of file formats without a problem and at no cost. 

The CT scan images would be processed as a 16-bit grayscale image (Figure 6), in black and 

white. The different color contrasts (black to white) represented variations in density associated 

with the different minerals (white) and pores (black).  
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Figure 6. (A) ImageJ tool bar. (B) CT scan processed image (16-bit) of sample from well Lott 

19-3, 4915’; Horizontal plug, slice 500 of 2237. Density contrast can be observed within the 

example. The white spots were interpreted as pyrite minerals with a higher density.  

  

 

Our next step in measuring the porosity values of the processed CT scan images was to 

convert the image into 8-bit greyscale, select an area of interest to analyze, then apply a threshold 

tool that would help us distinguish between porosity and solid material (Figure 7). For this 

research the method that was developed, was manual visualization and estimation of porosity. 

The threshold was applied based on the number of pores that were visible and then determined 

and estimated when all pores were filled up by the threshold tool. A lot of user input is involved 

when deciding when “all pores are filled” by the threshold tool, which can cause large systematic 

errors in the porosity measurements.  
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Figure 7. (A) Threshold tool window under Image>Adjust>Threshold. (B) Processed image with 

threshold tool applied highlighting pores with red color. Sample from Lott 19-3, 4915’; 

Horizontal plug, slice 500. Yellow lines represent area selected by the area select tool.  

 

Once the threshold was applied to the selected area, the next step would be to calculate 

the porosity for the area selected. Under the Analyze> Set Measurements tool, then Analyze> 

Measure to get the porosity percentage (Figure 8). Finally, after calculating the porosity for a 

single slice from the entire set of images, the following step would be to repeat the process for 

the next image and the entire batch. For this study, the images evaluated were from a range of 

500-1700, and within that range, every tenth image was analyzed. The reason for doing this was 

because the sample that was scanned was circular and the edges of the billet would prove more 

difficult to threshold (Figure 9) compared to the middle section images that are rectangular and 

more complete (Figure 8). 
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Figure 8. (A) Set Measure tool, showing the other analyzing options the program is able to 

calculate. (B) Results for porosity measurement, porosity measurement 30.334%.  

 

Figure 9. Image of slice #164, horizontal plug, Lott 19-3, 4915’. Edge of sample begins to be 

observed at this point. 
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Thin Section Porosity Measurements  

 The difference between the CT scan data and the scanned thin section images was the 

image type. CT scanned images were 16-bit as for the thin section images they were 8-bit RGB 

color and as mentioned before, the thin section images had to be modified by applying the blue 

color palette (Grove and Jerram, 2011). The way to do this was by opening the thin section 

image in Adobe Photoshop CC 2015, then clicking the Image> Mode> Indexed Color. Then 

under the Index Color window, select down on the Palette tab, and select Custom. You then 

would have to load the palette and select OK. Once the palette was selected, it would change 

some of the blue hue colors in the unedited image and then refine them with the color palette 

(Figure 10). With this method, the images could now be imported into ImageJ, and the program 

would be able to identify the blue hue with greater accuracy and precision.  
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Figure 10. (A) Preprocessed image. (B) Post processed. Thin section from Lott 19-7, 4949.3’. 
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Once the palette was applied the same process was repeated to all of the thin sections 

from wells Lott 19-7 and Lott 19-8. The next step would be to open ImageJ and select the JPOR 

tool (Figure 11) located in the toolbar. JPOR would request to select one of the thin sections that 

had been edited, then by following the directions appearing in the pop up window, the threshold 

would be applied to the thin section. Next, the perimeter for the thin section has to be selected in 

order to calculate porosity only for the desired area. Finally, the last step is to measure the 

porosity of the sample.  
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Figure 11. Step by step process on how to utilize the JPOR tool, to calculate porosity. Sample 

from Lott 19-7, 4949.3’. Porosity calculated, 22.43%. 
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Thin Section Cement Measurements 

Measuring cement percentages utilized a different method for the most part, but was 

similar to the thin section image analysis process for calculating porosity measurements 

nonetheless. To calculate the cementation, the unedited image would have to open in Adobe 

Photoshop. The key step here, was to zoom to the cemented area (preferably a small grain fully 

cemented) as much as possible until the cement grain image would be pixelated (Figure 12-A). 

Next step would be to select Image tab> Adjustments> Replace Color. In the Replace Color 

window, the user would have to select a single pixel inside the cemented area in order to replace 

the color (Figure 12-B). For this step an arbitrary color would be selected to replace the light 

colored pixels inside the cemented grain. For this study, green, or #00ff06, by its codename 

(Figure 12-C) was selected to highlight cementation.  
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Figure 12. (A) Cemented grain used to replace color of pixels. (B) Selection of one pixel will 

change other pixels with same color in the entire thin section. (C) Completed, color-changed 

cement.  
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The result will be a thin section image with cement colored in green (Figure 13). Next 

step, is to save the image and open in ImageJ. Cementation can now be observed with greater 

detail. It is recommended to use a bright “flashy” color that is not present in the thin section, this 

will make it easier to identify when the threshold tool is applied.  

Figure 13. (A) Preprocessed image. (B) Post processed image. Sample is from Lott 19-7, 

4967.2’. Total cement 11.5%. 
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The only difference here, is that the green colored “spikes” in the histogram have to be 

thresholded, as shown by Figure 14. The goal is to threshold these different spikes separately and 

add them together in order to calculate the total cementation present in the thin section. 

Figure 14. Histogram showing multiple green “spikes”.  
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CHAPTER III 

RESULTS 

 

Pore Types 

Within the two wells, Lott 19-7 and Lott 19-8, it was identified that there were three 

different pore types that helped compose the formation, which were moldic porosity, interparticle 

porosity, and intraparticle porosity. Moldic porosity can be classified as the selective removal of 

an individual constituent of the rock such as an oolith, and in the Happy Spraberry field this type 

was found within the oolitic-skeletal grainstone and packstones facies. Interparticle porosity is 

characterized by having original void space between grains from original deposition, and was 

found within the siltstone facies. Intraparticle porosity is characterized by having porosity within 

individual particles or grains, and was found within the rudstone facies.  

 

Interparticle Porosity 

The first pore type is interparticle porosity (Figure 15), which is found in the siltstone 

facies. This pore type developed from primary depositional processes and compaction of the 

siltstone deposits. The fine grain size and moderate levels of cement have the impact of causing 

relatively low porosity in the siltstone facies.  
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Figure 15. Thin section image from well, Lott 19-7, 4991.6’. Interparticle porosity highlighted by 

blue epoxy.  

 

 

Moldic Porosity 

 

The second pore type is moldic porosity (Figure 16), which can be found in the oolitic-

skeletal grainstone and packstone facies. The development of this type of porosity was due to the 

dissolution of ooids and allochems from the grainstone and packstone facies. Moldic porosity 

can be differentiated into incomplete and complete moldic pore types, which classify the degree 

of the material that has dissolved. The ooids from the moldic pore type are composed of a central 

nuclei of quartz or other carbonate particle surrounded by thin concentric layers of precipitated 

aragonite. When this aragonite dissolves in the water it leaves circular voids which in effect 

causes the rock to have greater porosity values. These voids cause moderate to high porosity 

values. 
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Figure 16. Thin section image from well, Lott 19-8, 4990.5’. Moldic and incomplete moldic 

porosities, highlighted by blue epoxy.  

 

 

Intraparticle Porosity 

 

The third pore type is intraparticle porosity (Figure 17), which can be found in the 

rudstone, floatstones and In situ Tubiphytes bindstones. The development of this porosity is due 

to the internal chambers, or openings, within the clasts or skeletal organisms that have or are in 

the process of dissolving.  This pore type causes facies to have moderate to high porosity values. 
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Figure 17. Thin section image from well, Lott 19-7, 4975.4’. Intraparticle porosity observed 

inside the bryozoan fragments, highlighted by blue epoxy.  

 

 

Porosity and Cement Results 
 

Porosity measurements done on the CT scan data, for the horizontal and vertical plugs, 

were not accurate, as our measurements overestimated the true values. It was found that the total 

porosity for the horizontal plug was 32.7% (Figure 18-A) and for the vertical plug 28.8% (Figure 

18-B).  

Figure 18. (A) Porosity changes as the transition through the sample for the horizontal plug, form 

well, Lott 19-3, 4915’. (B) Porosity changes through the specimen, this time for the vertical plug, 

from well, Lott 19-3, 4915’.  
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The results obtained from the petrographic image analysis method for wells, Lott 19-7 

and 19-8, proved to be more precise but not as accurate as our results followed the general 

porosity trend but underestimated the total porosity by a small factor (Figure 19 and Figure 20). 

The cement percentages calculated in this study are believed to show accurate and precise values 

for the actual cement present within the thin sections. 

Table 1 shows the porosity and cement measurements for well, Lott 19-7 for each thin 

section that was picked at depth. Figure 19 shows how the porosity values compare visually 

between the results from this study, Layman (2002) and Mazingue (2004). Cementation can also 

be observed in the right hand side of the graph, showing how cementation directly affects 

porosity in the rocks, where high cementation values often produce lower porosity 

measurements. 
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Figure 19. Porosity and cement values for well, Lott 19-7. 

 

Table 1. Well 19-7, porosity and cementation results.  
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Table 2 shows the porosity and cementation measurements for well, Lott 19-8 for each 

thin section that was picked at depth. Figure 20 shows how the porosity values compare visually 

between the results from this study, Layman (2002) and Mazingue (2004). Cementation can also 

be observed in the right hand side of the graph.  

Figure 20. Porosity and cementation values from well, Lott 19-8.  
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Table 2. Well Lott 19-8, porosity and cementation results. 

 

Discussion of Porosity Results 

The porosity values obtained through the petrographic image analyses method for wells, 

Lott 19-7 and 19-8, were lower than the benchmark porosity values obtained by Mazingue 

(2004). A linear regression model was done to compare the results from wells, Lott 19-7 and 19-

8, to the benchmark porosity results from Mazingue (2004). For Lott 19-7 the coefficient of 

determination is R² = 0.778 which indicates that 77.8% of the variation of porosity according to 

the methodology for Lott 19-7 lies within the trend of Mazingue’s data (Figure 21-A). Lott 19-8 

the coefficient of determination is R² = 0.767 which indicates that 76.7% of the variation of the 

porosity values according to the linear regression for Lott 19-8 lies within the trend of 

Mazingue’s data (Figure 21-B). The discrepancies were associated to the microporosity in the 

samples that the computer’s resolution was not able to pick up, even with the extended scanning 

time. Although the results of this study were lower, they did follow the same trend as Layman 
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(2002) and Mazingue (2004) data (Figure 19 and Figure 20). The method of the color palette 

from Grove and Jerram (2011) can be improved to further increase the accuracy and precision 

when calculating porosity of thin section images. This improvement of the color palette in 

conjunction with a better resolution and more complete imaging of the microporosity will 

improve the true area the computer will threshold as pore space. This in turn will give a more 

accurate porosity value closer to the total porosity of the samples. Much like Haines (2015) 

results, this methodology proved to underestimate the porosity from core samples. The major 

differences between this study’s overall results and that of Mazingue (2004) and Layman (2002) 

was the lower porosity value trend that was attributed to the microporosity that was missed in the 

thin section photo scans.  

Figure 21. Linear Regression models for (A) John Lott 19-7 and (B) Lott 19-8. 
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The CT imaging porosity values obtained through the ImageJ analysis method gave much 

higher estimates than the benchmark values used by Mazingue, for any of the other siltstone or 

grainstone facies. The large errors were associated to systematic human error when thresholding 

the thin section images, as it required a lot of personal judgement. This could be avoided by 

further improving the methodology by reducing the amount of human input.  
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CHAPTER IV 

CONCLUSION 
  

  The petrographic image analysis method used to measure the porosity and cementation 

values can be further improved in order to include the microporosity that was overlooked. 

Through this study it was apparent that image analysis, with a rework of the workflow to account 

for microporosity, can be an acceptable substitute to determine porosity in samples. Petrographic 

image analysis is a faster method than any other standard petrographic analyses methods, but it 

has certain downfalls that can affect the results, such as, poor quality images and systematic 

human error. Choosing a magnification that can properly image the microporosity in the 

samples, and improving the color palette are certain processes that can be improved for the 

petrographic image analysis workflow. The CT scan methodology proved to be a poor method to 

utilize due to large human error input when judging the threshold for the CT scan images. It is in 

the scope of this research to continue investigating and developing a new method for calculating 

porosity in the future, as there is still confidence that a method can be developed to accurately 

and precisely measure porosity values in CT scan data.  

 Finally, although due to time constraints, petrographic image analyses descriptions could 

not be developed in to the thesis body, but they were included in the APPENDIX. 
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APPENDIX 

 
Thin Section Description 

John Lott 19-7: Beginning of core. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4941.7’- 4954.7’ 
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Thin Section Description 

John Lott 19-7: Core continued. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4958.4’- 4970.2’ 
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Thin Section Description 

John Lott 19-7: Core continued.  

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4972.6’- 4981.2’ 
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Thin Section Description 

John Lott 19-7: End of core. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4972.6’- 4981.2’ 
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Thin Section Description 

John Lott 19-8: Beginning of core. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4917.1’- 4926.6’ 
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Thin Section Description 

John Lott 19-8: Core continued. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4927.1’- 4981.5’ 
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Thin Section Description 

John Lott 19-8: Core continued.  

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4982.2’- 4987.4’ 
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Thin Section Description 

John Lott 19-8: Core continued. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4988.9’- 4990.5’ 
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Thin Section Description 

John Lott 19-8: End of core. 

Happy Spraberry Field  

Garza County, Texas 

Core Interval 4993.4’- 4994.4’ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 


